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About this document

This document describes how to use the Device Inventory tools to produce 
reports on the hardware and software configuration of selected devices in 
your network.

The following topics are discussed in this section:

• “Who should read this document and why” (page 11)

• “What you need to know” (page 11)

• “How this document is organized” (page 12)

• “What’s new in this document” (page 12)

• “Related documents” (page 14)

Who should read this document and why
This document is intended for personnel who use and customize the Device 
Inventory tools to produce reports on the hardware and software 
configuration of Passport 7400, Passport 15000, and Passport 20000 series 
modules, and DPN-100 modules in their networks. 

What you need to know
The Device Inventory tools lets you produce reports from a graphical user 
interface (GUI) or a command line. Before using the Device Inventory tools, 
you should have a basic knowledge of Sun workstations and the UNIX 
operating system, and be familiar with Preside Multiservice Data Manager 
(MDM) user interface. To customize existing reports and to create new 
reports, you need to know how to program in DtKsh script and how to use EPI 
libraries.
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How this document is organized
This document consists of an introductory chapter that provides an overview 
of the Passport and DPN Inventory tools. This chapter is followed by chapters 
describing each tool in greater detail and that providing examples of the 
reports that you can produce.

241-6001-808 Preside MDM Device Inventory Tools User Guide contains the 
following sections:

• “Introducing the Inventory Reports tools” (page 15) gives a brief 
overview of the Inventory Reports tool for DPN and Passport devices 
and their functionality.

• “Passport Inventory Reports tool” (page 19) describes how you can 
produce reports on the Passport modules in your network.

• “DPN Inventory Reports tool” (page 35) describes how can produce 
reports on the DPN modules in your network.

• “Passport Inventory Reports” (page 49) provides examples of the reports 
that come with the Passport Inventory tool.

• “DPN Inventory Reports” (page 67) provides examples of the reports 
that come with the DPN Inventory tool.

What’s new in this document
There have not been any new changes to this NTP for this release.

Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.
241-6001-808   15.1RSUP   



About this document   13
• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE,lowercase

In Preside Multiservice Data Manager (MDM), uppercase and lowercase 
letters that appear in UNIX commands and parameters must be matched 
exactly. The system matches upper and lowercase characters differently.

• UPPERCASE,lowercase

Passport commands are not case-sensitive and do not have to match 
commands and parameters exactly as shown in this document, with the 
exception of string options values (for example, file and directory names) 
and string attribute values.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.

• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.
Preside MDM Device Inventory Tools User Guide   15.1RSUP
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The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Related documents
See the following documents for related information:

• 241-6001-211 Preside MDM Embedded Programming Interface 
Reference Guide
241-6001-808   15.1RSUP   
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Chapter 1
Introducing the Inventory Reports tools

This chapter provides an overview of the Inventory Reports tool for DPN and 
Passport devices. In this chapter, you can find the following information:

• “About the Inventory Reports tools” (page 15)

• “Inventory Reports configuration files” (page 16)

• “Customizing and creating reports” (page 16)

• “Starting the Inventory Reports tools” (page 16)

About the Inventory Reports tools
The Inventory Reports tools are reporting tools that let you report on the 
hardware and software configuration of selected devices in your network. 
Currently, you can produce reports on Passport 7400 and Passport 15000 
series modules, and DPN-100 modules.

The Passport and DPN Inventory Reports tools come with a set of pre-defined 
reports that you can use. You can also customize these reports and design new 
reports.

See also:

• “Passport Inventory Reports tool” (page 19)

• “DPN Inventory Reports tool” (page 35)

• “Inventory Reports configuration files” (page 16)

• “Customizing and creating reports” (page 16)

• “Starting the Inventory Reports tools” (page 16)
Preside MDM Device Inventory Tools User Guide   15.1RSUP
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Inventory Reports configuration files
There is a configuration file for each device for which you can produce 
reports. You can copy and edit these configuration files to add entries for the 
new reports that you design.

See also...

• “Passport inventory reports configuration file” (page 21)

• “DPN inventory reports configuration file” (page 37)

Customizing and creating reports
The Passport and DPN inventory reports are generated by DeskTop Korn 
Shell (DtKsh) scripts. These scripts use the Embedded Programming 
Interface (EPI) libraries to obtain information directly from the devices. For 
more information on DtKsh and EPI, see 241-6001-211 Preside MDM 
Embedded Programming Interface Reference Guide.

You can customize existing inventory reports and create new reports. By 
using a script-based approach such as DtKsh, you can change and create 
reports without the need for recompiling.

See also...

• “Customizing and creating Passport Inventory Reports” (page 21)

• “Customizing and creating DPN inventory reports” (page 37)

Starting the Inventory Reports tools
For Passport and DPN devices, you can start the Inventory Reports tools from 
the Preside MDM window or by using line commands. In addition, there are 
line commands that let you produce Inventory reports independently of the 
GUI.

See also...

• “Starting the Passport Inventory Reports tool” (page 20)

• “Producing reports using a command line” (page 31)

• “Starting the DPN Inventory Reports tool” (page 36)
241-6001-808   15.1RSUP   
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• “Producing reports using a command line” (page 46)
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Chapter 2
Passport Inventory Reports tool

This chapter describes the Inventory Reports tool for Passport devices and 
contains procedures for using it. The Passport Inventory Reports tool 
supports Passport 7400, Passport 15000, and Passport 20000 series modules.

In this chapter, you can find the following information:

• “About the Passport Inventory Reports tool” (page 19)

• “Starting the Passport Inventory Reports tool” (page 20)

• “Customizing and creating Passport Inventory Reports” (page 21)

• “Passport inventory reports configuration file” (page 21)

• “Passport Inventory Reports tool window” (page 23)

• “Passport Inventory Reports tool dialogs” (page 26)

• “Passport Inventory Reports tool procedures” (page 30)

• “Using the keyboard” (page 32)

About the Passport Inventory Reports tool
The Passport Inventory Reports tool lets you produce reports for the 
modules in a Passport group or for a specific module. In addition to using 
existing reports, you can design custom reports. The reports can be produced 
from a graphical user interface or from a command line. 

See also...

• “Customizing and creating Passport Inventory Reports” (page 21)

• “Passport inventory reports configuration file” (page 21)
Preside MDM Device Inventory Tools User Guide   15.1RSUP
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• “Passport Inventory Reports tool window” (page 23)

• “Passport Inventory Reports tool dialogs” (page 26)

• “Passport Inventory Reports tool procedures” (page 30)

• “Using the keyboard” (page 32)

Starting the Passport Inventory Reports tool
In the Preside MDM window, select Configuration -> Passport -> 
Inventory Reports. This opens the Passport Inventory Reports Tool 
window.

As an alternative, you can use a line command to launch the Passport 
Inventory Tool window. Enter the following command:

/opt/MagellanNMS/bin/pprep [-group <group_name> ]
[-comp <module_name>] [-rep <report_name>] [-h]

where:

group_name is the name of the Passport group on which you want to 
report. This field is not case-sensitive.

-h displays online help for this command.

module_name is the name of the Passport module on which you want to 
report. This field is not case-sensitive and can be in any valid format, for 
example, -comp node1A, -comp EM/node1A, or -comp EM node1A.

report_name is the identifier of a report. When you use the -rep parameter, 
the specified report is generated as soon as the Passport Inventory Tool 
window opens. The names of available reports are specified in the 
configuration file pprep.reports using the option 
createReportBTN <report_name>. See “Configuration file format” 
(page 22) for more information.

Example
The following command opens the Passport Inventory Tool window and 
produces the Frame Relay Services Report for Passport module PP1:
241-6001-808   15.1RSUP   
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/opt/MagellanNMS/bin/pprep -comp EM/PP1 
-rep PP_FR_REPORT

Customizing and creating Passport Inventory Reports
The Passport inventory reports are generated using DeskTop Korn Shell 
(DtKsh) scripts. These scripts use the Embedded Programming Interface 
(EPI) libraries to obtain information directly from the Passport nodes.

To customize existing reports and create new reports, you need to know how 
to program in DtKsh script and how to use the EPI libraries. For more 
information, see 241-6001-211 Preside MDM Embedded Programming 
Interface Reference Guide. 

The Passport Inventory Reports tool searches for the report scripts in the 
following directories and in the following order:

1 $HOME/MagellanNMS
This directory contains the report scripts that are available to a single 
Preside Multiservice Data Manager (MDM) user.

2 /opt/MagellanNMS/cfg/macros/user
This directory contains the report scripts that are available to all MDM 
users.

3 /opt/MagellanNMS/lib/macros/nms
This directory contains the report scripts that come with the MDM 
software. These report scripts should never be modified. When you need 
to override these report scripts or when you create new report scripts, 
place the updates in either the first or second location.

When you create a new report, you need to add a new entry to the Passport 
inventory reports configuration file pprep.reports. For more information, see 
“Passport inventory reports configuration file” (page 21).

Passport inventory reports configuration file
All of the Passport inventory reports are specified in the configuration file 
pprep.reports. You can copy and customize this file to reflect any new reports 
that are added to the Passport Inventory Reports tool. 

See also...

• “Configuration file location” (page 22)
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• “Configuration file format” (page 22)

Configuration file location
The Passport Inventory Reports tool searches for the configuration file in 
the following directories and in the following order:

1 $HOME/MagellanNMS
To customize the reports available to a single user, copy the configuration 
file to this directory and make your changes.

2 /opt/MagellanNMS/cfg
To customize the reports available on a workstation, copy the 
configuration file to this directory and make your changes.

3 /opt/MagellanNMS/lib/cfg
This directory is the default location of the configuration file. Do not edit 
the configuration file in this directory; instead use it as the source when 
you want to copy pprep.reports to the other directories.

Configuration file format
The pprep.reports file contains DtKsh commands in the following format:

createReportBtn <report_name> \
“<report_button_label>” \
“<btn_mnemonic>” “<btn_accelerator>” \
“<btn_acc_label>” \
“scriptReport <report_script_name>” 

where:

btn_acc_label is the text string, specifying the keyboard accelerator for 
this report, that is displayed in the Reports menu.

btn_accelerator is the keyboard accelerator for this report.

btn_mnemonic is the keyboard mnemonic key for this report.

report_button_label is the text string, specifying the title for this 
report, that is displayed in the Reports menu.

report_name is a unique report identifier. No spaces are allowed.
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report_script_name is the name of the reporting script. The Passport 
Inventory Reports tool searches for the script in the following directories 
and in the following order: 

$HOME/MagellanNMS
/opt/MagellanNMS/cfg/macros/user 
/opt/MagellanNMS/lib/macros/nms.

You can override the default directories by including the full pathname as part 
of report_script_name.

Example 1
createReportBtn PP_FR_REPORT \
“Frame Relay Services Report” \
“F” “Ctrl<Key>f” “Ctrl+f” \
“scriptReport ppfrrep” 

Example 2
You can produce the same report as above, but from a directory of your 
choice by including the full pathname:

createReportBtn PP_FR_REPORT \
“Frame Relay Services Report” \
“F” “Ctrl<Key>f” “Ctrl+f” \
“scriptReport /home/nmsuser/bin/ppfrrep” 

Passport Inventory Reports tool window
The Passport Inventory Reports tool window contains the following 
sections:

• “Menu bar” (page 24)

• “Passport Group field” (page 25)

• “Module field” (page 26)

• “Report area” (page 26)

See the figure “Passport Inventory Tool window” (page 24) for an example of 
the Passport Inventory Reports Tool window.
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Figure 1
Passport Inventory Tool window

Menu bar
The menu bar is located at the top of the Passport Inventory Reports Tool 
window. See the following sections for information on the menu bar entries:

• “File menu” (page 24)

• “Edit menu” (page 25)

• “Reports menu” (page 25)

• “Options menu” (page 25)

File menu
The File menu contains the following options:

• Save as opens the Save Report to File dialog. This dialog lets you save 
the report output to a file that you specify. See also “Save Report to File 
dialog” (page 28).

• Print opens the Print Report dialog, which allows you to print the 
report output. See also “Print Report dialog” (page 29).

• Exit exits the Passport Inventory Reports tool. 
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Edit menu
The Edit menu contains options for editing text in the report area. The options 
are:

• Cut removes any selected text and places it in a cut/copy buffer.

• Copy copies any selected text and places it in a cut/copy buffer.

• Paste places the last cut or copied text at the insertion point in the report 
area.

• Delete deletes any selected text.

Reports menu
The Reports menu lists all available Passport inventory reports. You can add 
custom reports to this menu. Until you specify a Passport Group name and/
or Module name on the Passport Inventory Reports window, all reports are 
grayed out and unselectable except for List Available Modules and Groups.

The reports listed in the Reports menu are specified in the configuration file 
pprep.reports. For more information on this file, see “Passport inventory 
reports configuration file” (page 21).

Options menu
The Options menu contains the following options:

• Append to Existing Text lets you add any new report output to the 
existing report output. If you do not select this option, any new report 
output replaces the existing report output. By default, this option is 
enabled. 

• Generate CSV Output lets you save any new report output as CSV data. 
You can use CSV data as input to a spreadsheet. If you do not select this 
option, any new report output is displayed as usual. By default, this 
option is disabled. 

Passport Group field
This field is optional. Enter the name of the Passport group on which you 
want to report. If you want information on a particular module, leave this field 
empty and enter the module name in the Module field.
Preside MDM Device Inventory Tools User Guide   15.1RSUP
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If you enter the Passport group and not a module, the report is produced for 
all modules in the specified group. If you do not specify a Passport group or 
a module name, the only report you can create is List Available Modules and 
Groups.

Module field
This field is optional. You can enter the name of the module on which you 
want to report. 

When you use the Module field and not the Passport Group field, the correct 
group is obtained from the HGDS server. If you do not specify a Passport 
group or a module name, the only report you can create is List Available 
Modules and Groups.

Report area
This scrollable area displays the reports you create and any messages 
generated by the Passport Inventory Reports tool. 

Passport Inventory Reports tool dialogs
See the following sections for information on Passport Inventory Reports 
tool dialogs:

• “Passport Authentication dialog” (page 26)

• “Card Inventory Options dialog” (page 27)

• “Save Report to File dialog” (page 28)

• “Print Report dialog” (page 29)

Passport Authentication dialog
The Passport Authentication dialog is displayed when you try to generate a 
report and you do not have a connection to the required Passport group. This 
dialog prompts you for a Passport group, user ID, and password, which are 
required before authentication can take place. The buttons are:

• OK completes the connection and closes the dialog.

• Cancel stops the connection attempt and closes the dialog.
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For an illustration of the Passport Authentication dialog, see the figure 
“Passport Authentication dialog” (page 27).

Figure 2
Passport Authentication dialog 

Card Inventory Options dialog
The Card Inventory Options dialog opens when you select the Passport 
Card Inventory command from the Reports menu. This dialog lets you sort 
the Passport card inventory by card type or report on a card type that you 
specify. The Card Type Filter field is not case-sensitive and you cannot use 
wildcards.

The buttons are:

• OK uses the information you enter to produce the Passport Card 
Inventory report and closes the dialog.

• Cancel closes the dialog without producing the Passport Card 
Inventory report.
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Ror an illustration of the Card Inventory Options dialog, see the figure 
“Card Inventory Options dialog” (page 28).

Figure 3
Card Inventory Options dialog

Save Report to File dialog
The Save Report to File dialog lets you specify the name of a file for saving 
the current report output

The buttons are:

• OK saves your report in the file you specify and closes the dialog.

• Filter lets you choose what files are listed.

• Cancel closes the dialog without saving your report.

For an illustration of the Save Report to File dialog, see the figure “Save 
Report to File dialog” (page 29).
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Figure 4
Save Report to File dialog 

Print Report dialog
The Print Report dialog lets you enter a printer name when you print a 
report.

The buttons are:

• OK prints the report and closes the dialog.

• Cancel closes the dialog without printing the report.

For an illustration of the Print Report dialog, see the figure “Print Report 
dialog” (page 30).
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Figure 5
Print Report dialog 

Passport Inventory Reports tool procedures
See the following sections for information on Passport Inventory Reports 
procedures:

• “Producing reports using the Passport Inventory Reports tool window” 
(page 30)

• “Producing reports using a command line” (page 31)

Producing reports using the Passport Inventory Reports tool 
window

You can select a Passport group, module, and report from the Passport 
Inventory Reports tool window. You need to establish a connection to a 
Passport group or module before you can produce a report. 

1 On the Passport Inventory Tool window, in the Passport Group field, 
enter the Passport group. Optionally, you can enter the module name in 
the and/or Module field.

If you specify only the Passport group, the report is produced for all 
modules in the specified group.

If you specify only the module, the correct group is obtained from the 
HGDS server and the report is produced only for the specified module.

Note:  If you enter nothing in the Passport Group and the and/or 
Module fields, the only report you can produce is List Available Modules 
and Groups.
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2 From the Options menu, deselect Append to existing text if you want 
the new report output to replace existing report output. By default, 
Append to existing text is selected.

3 From the Options menu, select Generate CSV output if you want to 
save the new report output as CSV data. By default, Generate CSV 
output is deselected.

4 From the Reports menu, select a report.

If no connection exists to the required Passport group, the Passport 
Authentication dialog opens. See “Passport Authentication dialog” 
(page 27).

5 In the Passport Authentication dialog, enter the Passport Group, User 
ID, and Password and click OK.

When a valid connection exists, the report is created and appears in the 
report area.

If there is a connection to the Passport group, the report is created and is 
displayed in the report area.

Producing reports using a command line
You can use a command line to produce reports independently of the 
graphical user interface. The report output goes to stdout. The command 
syntax is:

/<pathname>/<report_script_name> 
[-group <group_name> ] [-u <userid> -p <password>]
[-csv] [-st] 
[-ft <card_type>] [-h] [module(s)]

where:

pathname is the directory where the report script resides.

report_script_name is the script name of the report that you need to 
produce. The script names of available reports are specified in the 
configuration file pprep.reports using the option 
scriptReport <report_script_name>. See “Configuration file format” 
(page 22) for more information. 

- group <group_name> is the name of the Passport group on which you 
want to report. This field is not case-sensitive.
Preside MDM Device Inventory Tools User Guide   15.1RSUP



32   Chapter 2 Passport Inventory Reports tool
-u <userid> is the userid for logging on to a Passport group.

-p <password> is the password for the userid specified by the -u option.

-csv formats the report output in CSV format. 

-st is used only for the Passport Card Inventory. This option sorts the card 
inventory by card type. 

-ft <card_type> The -ft option filters the card inventory by the specified 
card type. <card type> is used only for the Passport Card Inventory. 

-h displays online help for this command.

module(s) is the name(s) of the Passport module(s) on which you want to 
report. This field is not case-sensitive.

Note: All command options must appear before the module names.

Example
The following command is used to produce the Passport ATM Services 
Report for group ALPHA. In this case the directory containing the report 
scripts that come with the MDM software is used.

/opt/MagellanNMS/lib/macros/nms/ppatmrep -group ALPHA

Using the keyboard
You can produce any Passport inventory report by using its command 
accelerator, which is displayed in the Reports menu.

In addition, the Passport Inventory Reports tool provides the following 
keyboard shortcuts:

• Ctrl+s for Save as

• Ctrl +p for Print

• Ctrl+e for Exit
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Some characters in menus and in menu items have an underscore (_). These 
characters are mnemonics that you can use instead of using the mouse. Use 
the Meta key in combination with the mnemonics. 

Examples
Meta+f on the Passport Inventory Reports tool window opens the File 
menu.

Meta+c on the Edit menu is the same as Copy.
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Chapter 3
DPN Inventory Reports tool

This chapter describes the DPN Inventory tool and contains procedures for 
using it. In this chapter, you can find the following information:

• “About the DPN Inventory Reports tool” (page 35)

• “Starting the DPN Inventory Reports tool” (page 36)

• “Customizing and creating DPN inventory reports” (page 37)

• “DPN inventory reports configuration file” (page 37)

• “DPN Inventory Reports tool window” (page 39)

• “DPN Inventory Reports tool dialogs” (page 42)

• “DPN Inventory Reports tool procedures” (page 45)

• “Using the keyboard” (page 47)

About the DPN Inventory Reports tool
The DPN Inventory Reports tool lets you produce reports for the modules 
under an operations agent (OA) or for a specific module. In addition to using 
existing reports, you can design custom reports. The reports can be produced 
from a GUI or from a command line. 

See also...

• “Customizing and creating DPN inventory reports” (page 37)

• “DPN inventory reports configuration file” (page 37)

• “DPN Inventory Reports tool window” (page 39)
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• “DPN Inventory Reports tool dialogs” (page 42)

• “DPN Inventory Reports tool procedures” (page 45)

• “Using the keyboard” (page 47)

Starting the DPN Inventory Reports tool
To open the DPN Inventory Reports tool window, from the Preside MDM 
window, select Configuration -> DPN -> Inventory Reports. 

As an alternative, you can use a line command to launch the Device Inventory 
main window. Enter the following command:

/opt/MagellanNMS/bin/dpnrep [-oa <oa_name> ]
[-comp <module_name>] [-rep <report_name>] [-h]

where:

-h displays online help for this command.

module_name is the name of the DPN module on which you want to report. 
This field is not case-sensitive and can be in any valid format, for example, 
-comp node1A, -comp PM/node1A, or -comp PM node1A.

oa_name is the name of the OA on which you want to report. This field is 
not case-sensitive.

report_name is the identifier of a report. When you use the -rep parameter, 
the specified report is generated as soon as the DPN Inventory main window 
opens. The names of available reports are specified in the configuration file 
dpnrep.reports using the option 
createReportBTN <report_name>. See “Configuration file format” (page 38) 
for more information.

Example
The following command opens the DPN Inventory main window and 
produces the DPN PE Report for DPN module RM1:

/opt/MagellanNMS/bin/dpnrep -oa BNROA -comp PM/RM1 
-rep DPN_PE_REPORT
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Customizing and creating DPN inventory reports
The DPN inventory reports are generated using DeskTop Korn Shell (DtKsh) 
scripts. These scripts use the Embedded Programming Interface (EPI) 
libraries to obtain information directly from the DPN nodes.

To customize existing reports and create new reports, you need to know how 
to program in DtKsh script and how to use the EPI libraries. For more 
information, see 241-6001-211 Preside MDM Embedded Programming 
Interface Reference Guide. 

The DPN Inventory Reports tools searches for the report scripts in the 
following directories and in the following order:

1 $HOME/MagellanNMS
This directory contains the report scripts that are available to a single 
Preside Multiservice Data Manager (MDM) user.

2 /opt/MagellanNMS/cfg/macros/user
This directory contains the report scripts that are available to all MDM 
users.

3 /opt/MagellanNMS/lib/macros/nms
This directory contains the report scripts that come with the MDM 
software. These report scripts should never be modified. When you need 
to override these report scripts or when you create new report scripts, 
place the updates in either the first or second location.

When you create a new report, you need to add a new entry to the DPN 
Inventory configuration file dpnrep.reports. For more information, see “DPN 
inventory reports configuration file” (page 37). 

DPN inventory reports configuration file
All of the DPN inventory reports are specified in the configuration file 
dpnrep.reports. You can copy and customize this file to reflect any new reports 
that are added to the DPN Inventory Reports tool. 

See also...

• “Configuration file location” (page 38)

• “Configuration file format” (page 38)
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Configuration file location
The DPN Inventory Reports tool searches for the configuration file in the 
following directories and in the following order:

1 $HOME/MagellanNMS
To customize the reports available to a single user, copy the configuration 
file to this directory and make your changes.

2 /opt/MagellanNMS/cfg
To customize the reports available on a workstation, copy the 
configuration file to this directory and make your changes.

3 /opt/MagellanNMS/lib/cfg
This directory is the default location of the configuration file. Do not edit 
the configuration file in this directory; instead use it as the source when 
you want to copy dpnrep.reports to the other directories.

Configuration file format
The dpnrep.reports file contains DtKsh commands in the following format:

createReportBtn <report_name> \
“<report_button_label>” \
“<btn_mnemonic>” “<btn_accelerator>” \
“<btn_acc_label>” \
“scriptReport <report_script_name>” 

where:

btn_acc_label is the text string, specifying the keyboard accelerator for 
this report, that is displayed in the Reports menu.

btn_accelerator is the keyboard accelerator for this report.

btn_mnemonic is the keyboard mnemonic key for this report.

report_button_label is the text string, specifying the title for this 
report, that is displayed in the Reports menu.

report_name is a unique report identifier. No spaces are allowed.
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report_script_name is the name of the reporting script. The DPN 
Inventory Reports tool searches for the script in the following directories 
and in the following order: 

$HOME/MagellanNMS
/opt/MagellanNMS/cfg/macros/user 
/opt/MagellanNMS/lib/macros/nms.

You can override the default directories by including the full pathname as part 
of report_script_name.

Example 1
createReportBtn DPN_PE_REPORT \
“PE INVENTORY” \
“P” “Ctrl<Key>p” “Ctrl+p” \
“scriptReport dpnperep” 

Example 2
You can produce the same report as above, but from a directory of your 
choice by including the full pathname:

createReportBtn DPN_PE_REPORT \
“PE INVENTORY” \
“P” “Ctrl<Key>p” “Ctrl+p” \
“scriptReport /home/nmsuser/bin/dpnperep” 

DPN Inventory Reports tool window
The DPN Inventory Reports tool window contains the following sections:

• “Menu bar” (page 40)

• “OA data field” (page 42)

• “Module data field” (page 42)

• “Report area” (page 42)
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Figure 6
DPN Inventory Tool window

Menu bar
The menu bar is located at the top of the DPN Inventory Reports tool 
window. See the following sections for information on the menu bar entries:

• “File menu” (page 40)

• “Edit menu” (page 41)

• “Reports menu” (page 41)

• “Options menu” (page 41)

File menu
The File menu contains the following options:

• Save as opens the Save Report to File dialog. This dialog lets you save 
the report output to a file that you specify. See also “Save Report to File 
dialog” (page 43).
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• Print opens the Print Report dialog, which allows you to print the 
report output. See also “Print Report dialog” (page 44).

• Exit exits the DPN Inventory Reports tool. 

Edit menu
The Edit menu contains options for editing text in the report area. The options 
are:

• Cut removes any selected text and places it in a cut/copy buffer.

• Copy copies any selected text and places it in a cut/copy buffer.

• Paste places the last cut or copied text at the insertion point in the report 
area.

• Delete deletes any selected text.

Reports menu
The Reports menu lists all available DPN inventory reports. You can add 
custom reports to this menu. Until you specify an OA name or module name 
on the DPN Inventory Reports window, all reports are grayed out and 
unselectable.

The reports listed in the Reports menu are specified in the configuration file 
dpnrep.reports. For more information on this file, see “DPN inventory reports 
configuration file” (page 37).

Options menu
The Options menu contains the following options:

• Append to Existing Text lets you add any new report output to the 
existing report output. If you do not select this option, any new report 
output replaces the existing report output. By default, this option is 
enabled. 

• Generate CSV Output lets you save any new report output as CSV data. 
You can use CSV data as input to a spreadsheet. If you do not select this 
option, any new report output is displayed as usual. By default, this 
option is disabled. 
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OA data field
The OA field is mandatory. Enter the name of the OA on which you want to 
report. If you want information on a particular module, enter the module 
name in the Module field.

If you enter the OA and not a module, the report is produced for all modules 
under the specified OA. Subordinate OAs are traversed, with modules under 
them also reported on. If you leave the OA and Module fields blank, you 
cannot produce any reports. 

Module data field
This field is optional. You can enter the name of the module on which you 
want to report. 

Report area
This scrollable area displays the reports you create and any messages 
generated by the DPN Inventory Reports tool. 

DPN Inventory Reports tool dialogs
See the following sections for information on DPN Inventory Reports tool 
dialogs:

• “OA Authentication dialog” (page 42)

• “Save Report to File dialog” (page 43)

• “Print Report dialog” (page 44)

OA Authentication dialog
The OA Authentication dialog is displayed when you try to generate a report 
and you do not have a connection to the required OA. This dialog prompts you 
for a destination OA, user ID, and password, which are required before 
authentication can take place.

The buttons are:

• OK completes the connection and closes the dialog.

• Cancel stops the connection attempt and closes the dialog.
241-6001-808   15.1RSUP   



Chapter 3 DPN Inventory Reports tool   43
For an illustration of the OA Authentication dialog, see the figure “OA 
Authentication dialog” (page 43).

Figure 7
OA Authentication dialog

Save Report to File dialog
The Save Report to File dialog lets you specify the name of a file for saving 
the current report output.

The buttons are:

• OK saves your report in the file you specify and closes the dialog.

• Filter lets you choose what files are listed.

• Cancel closes the dialog without saving your report.

For an illustration of the Save Report to File dialog, see the figure “Save 
Report to File dialog” (page 44).
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Figure 8
Save Report to File dialog

Print Report dialog
The Print Report dialog lets you enter a printer name when you print a 
report. The Print Report dialog has the following buttons:

• OK prints the report and closes the dialog.

• Cancel closes the dialog without printing the report.

For an illustration of the Print Report dialog, see the figure “Print Report 
dialog” (page 45).
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Figure 9
Print Report dialog 

DPN Inventory Reports tool procedures
See the following sections for information on DPN Inventory Reports tool 
procedures:

• “Producing reports using the DPN Inventory Reports tool window” 
(page 45)

• “Producing reports using a command line” (page 46)

Producing reports using the DPN Inventory Reports tool 
window

You can select the OA, module, and report from the DPN Inventory Reports 
tool window. You need to establish a connection to an OA or module before 
you can produce a report. 

1 On the DPN Inventory Reportsl window, fill in the OA and the and/or 
Module fields.

If you specify only the OA, the report is produced for all modules in the 
specified group. Subordinate OAs are traversed, with modules under 
them also reported on.

If you specify only the module, the report is produced only for the specified 
module.

Note:  You cannot produce a report until you fill in either the OA or the 
and/or Module fields.

2 From the Options menu, deselect Append to existing text if you want 
the new report output to replace existing report output. By default, 
Append to existing text is selected.
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3 From the Options menu, select Generate CSV output if you want to save 
the new report output as CSV data. By default, Generate CSV output is 
deselected.

4 From the Reports menu, select a report.

If no connection exists to the required OA, the OA Authentication dialog 
opens. 

In the OA Authentication dialog, enter the Destination OA, User ID, and 
Password and click OK.

When a valid connection exists, the report is created and appears in the 
report area.

Producing reports using a command line
You can use a command line to produce reports independently of the 
graphical user interface. The report output goes to stdout. The command 
syntax is:

/<pathname>/<report_script_name> 
-oa <oa_name> [-cap <capability> -pwd <password]
[-csv] [-h] [module(s)] 

where:

capability is a user ID for creating a connection to the required OA. You 
must specify the -cap option when there is no connection to the required OA. 

-csv formats the report output in CSV format. 

-h displays online help for this command.

module(s) is the name(s) of the DPN module(s) on which you want to 
report. This field is not case-sensitive.

oa_name is the name of the OA on which you want to report. This field is 
not case-sensitive.

password is the password for creating a connection to the required OA. You 
must specify the -pwd option when there is no connection to the required OA. 

pathname is the directory where the report script resides.
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report_script_name is the script name of the report that you need to 
produce. The script names of available reports are specified in the 
configuration file dpnrep.reports using the option 
scriptReport <report_script_name>. See “Configuration file format” 
(page 38) for more information. 

Note: All command options must appear before the module names.

Examples
The following command is used to produce the DPN SCR Report for 
specified RMs. The directory containing the report scripts that come with 
the Preside Multiservice Data Manager (MDM) software is used. The 
report is produced using a new connection and the output is formatted in 
CSV format.

/opt/MagellanNMS/lib/macros/nms/dpnscrrep -oa mainoa 
-cap capcmd -pwd cappwd -csv RM1 RM2 RM3

The following command is used to produce the DPN Full Module 
Report for all modules. The report is produced using an existing 
connection.

/opt/MagellanNMS/lib/macros/nms/dpnmodrep -oa mainoa

Using the keyboard
You can produce any DPN inventory report by using its command accelerator, 
which is displayed in the Reports menu.

In addition, the DPN Inventory Reports tool provides the following 
keyboard shortcuts:

• Ctrl+s for Save as

• Ctrl+p for Print

• Ctrl+e for Exit

Some characters in menus and in menu items have an underscore (_). These 
characters are mnemonics that you can use instead of using the mouse. Use 
the Meta key in combination with the mnemonics.
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Examples
Meta+f on the DPN Inventory Reports tool window opens the File 
menu.

Meta+c on the Edit menu is the same as Copy.
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Appendix A
Passport Inventory Reports

This appendix provides examples of the reports that come with the Passport 
Inventory Reports tool. See the following sections for information on these 
reports: 

• “Available Passport Groups and Modules (pplistrep)” (page 50)

• “Passport Full Module Report (ppmodrep)” (page 51)

• “Passport Card Inventory (ppcardrep)” (page 53)

• “Passport Trunk and DPNGate Report (pptrkrep)” (page 54)

• “Passport Software Report (ppsoftrep)” (page 55)

• “Passport Frame Relay Services Report (ppfrrep)” (page 58)

• “Passport ATM Services Report (ppatmrep))” (page 60)

• “Passport Frame Relay ATM Services Report (ppfratmrep)” (page 62)
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Available Passport Groups and Modules (pplistrep)
This report lists the available Passport modules and groups by querying the 
HGDS server.

The following example shows the Available Passport Groups and Modules 
report.

Available Passport Groups and Modules
--------------------------------------------------------

                      Server: bhars836
                              Date: Tue Feb 15 11:53:35 GMT 2000

 Group: ALPHA
-------------------
        BHARY145
        BUNGLE
        GEORGE
        ZIPPY

 Group: HARLOW
-------------------
        BHARY12C
        BHARY134
        BHARY136
        BHARY144
        BHARY46D
        BHARY472
        BHARY491
        BHARY492
        BHARY49C
        BHARY7F9
        BHARY7FE

------------------------------ done ---------------------
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Passport Full Module Report (ppmodrep)
This report provides a full inventory of a Passport module, including the 
module name, node ID, NAMS ID, network ID, routing ID, module ID, and 
model. In addition, it contains information about the file system and disks and 
all of the information contained in the Passport Card Inventory and Passport 
Trunk and DPNGate reports. 

The following example shows a Passport Full Module Report.

                   Passport Full Module Report
------------------------------------------------------------------------

                                   Server: bhars836

                                     Date: Tue Mar 28 16:29:08 BST 2000

     Node Name: GEORGE
       Node ID: 2
       NAMS ID: 7002
    Network ID: 1
    Routing ID: 7
     Module ID: 2
Software Level: BE00S9B
         Slots: 16

Card Type               Inserted         Serial #         Product Code   LP
---- ----------------   ---------------- --------------   ------------   -------
0    CP                 CP               NNTM03013KM3     NTFN33AA-08    Lp/0
1    2pDS3cAal          2pDS3cAal        15XM1            ““             Lp/1
2    V35                V35              FT003876         NTBP16DB-01    Lp/2
3    V11                V11              FT003896         NTBP38EA-01    Lp/3
4    3pE1Atm            3pE1Atm          NNTM03004WVC     NTFP32AB-01    Lp/4
5    1pE1V              1pE1V            PPSN003099       NTFP43AB-03    Lp/5
6    2pJ6MAtm           2pJ6MAtm         NNTM03004NYK     NTFP58AB-01    Lp/6
7    4pDS1Aal1          4pDS1Aal1        NNTM030089NR     NTFP80AB-01    Lp/7
8    3pDS3Atm           3pDS3Atm         NNTM03012CDF     NTFP18DA-02    Lp/8
9    2pJ6MAtm           2pJ6MAtm         NNTM03004NYG     NTFP58AB-01    Lp/6
10   4pE1Aal1           4pE1Aal1         NNTM03011ZGD     NTFP82AC-01    Lp/10
11   12mVspAs1          12mVspAs1        ““               NTFN87AB-06    Lp/11
12   none               none             None             None                 
13   4pDS1Aall          4pDS1Aall        NNTM03014B6P     NTEP80AC-04    Lp/12
14   4pE1Aal1           4pE1Aal1         NNTM03011D9M     NTFP82AA-05    Lp/14
15   CP                 none             None             None           
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Trunk     Type      M. Speed   M. Delay   Remote Name  Remote Endpoint
                    (bits/s)   (msec)
--------- --------- ---------- ---------- ------------ --------------------- - -
Trk/1     PORS               0        0.0              
Trk/2     PORS         1918000        1.4              EM/ZIPPY TRK/2
Trk/3     PORS               0        0.0              
Trk/4     PORS               0        0.0              
Trk/31    PORS               0        0.0              
Trk/60    PORS  Atm    1152000        1.0              EM/HARRY TRK/31
Trk/801   PORS  Atm    6144000        0.3 Zippy        EM/ZIPPY TRK/801
Trk/802   PORS  Atm    6144000        0.3 Zippy        EM/ZIPPY TRK/802
Trk/803   PORS  Atm    6144000        0.3 Zippy        EM/ZIPPY TRK/803

File System
--------------
  Volume Name: GEORGE
  Active Disk: Fs
 Synchronized: unSynchronized
     Capacity: 811122688 bytes
   Free Space: 232079360 bytes
        Usage: 71 %

         Disk: Disk/0
  Volume Name: GEORGE
     Capacity: 811122688 bytes
   Free Space: 232079360 bytes
   Bad Blocks: 0 %

------------------------------ done ------------------------------------
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Passport Card Inventory (ppcardrep)
This report provides a full card inventory for a Passport module. You can sort 
and filter the report output by card type. The following information is 
displayed for each card: module name, card number, configured card type, 
inserted card type, card serial number, product code, and logical processor. 

The following example shows a Passport Card Inventory report.

                      Passport Card Inventory
------------------------------------------------------------------------

                                   Server: bhars836

                                     Date: Tue Feb 15 11:55:49 GMT 2000

Node         Card Type             Inserted         Serial #       Product Code  LP
------------ ---- ---------------- ---------------- -------------- ------------  ------
GEORGE       0    CP               CP               NNTM03013KM3   NTFN33AA-08   Lp/0
GEORGE       1    2pDS3cAal        2pDS3cAal        15XM1          ““            Lp/1
GEORGE       2    V35              V35              FT003876       NTBP16DB-01   Lp/2
GEORGE       3    V11              V11              FT003896       NTBP38EA-01   Lp/3
GEORGE       4    3pE1Atm          3pE1Atm          NNTM03004WVC   NTFP32AB-01   Lp/4
GEORGE       5    1pE1V            1pE1V            PPSN003099     NTFP43AB-03   Lp/5
GEORGE       6    2pJ6MAtm         2pJ6MAtm         NNTM03004NYK   NTFP58AB-01   Lp/6
GEORGE       7    4pDS1Aal1        4pDS1Aal1        NNTM030089NR   NTFP80AB-01   Lp/7
GEORGE       8    3pDS3Atm         3pDS3Atm         NNTM03012CDF   NTFP18DA-02   Lp/8
GEORGE       9    2pJ6MAtm         2pJ6MAtm         NNTM03004NYG   NTFP58AB-01   Lp/6
GEORGE       10   4pE1Aal1         4pE1Aal1         NNTM03011ZGD   NTFP82AC-01   Lp/10
GEORGE       11   12mVspAal        12mVspAal        ““             NTFN87AB-06   Lp/11
GEORGE       12   none             none             None           None
GEORGE       13   4pDS1Aal1        4pDS1Aal1        NNTM03014B6P   NTFP80AC-04   Lp/12
GEORGE       14   4pE1Aal1         4pE1Aal1         NNTM03011D9M   NTFP82AA-05   Lp/14
GEORGE       15   CP               none             None           None               
HARRY        0    CP               CP               NNTM030018PS   NTBP12CA-03   Lp/0
HARRY        1    DS1              DS1              FT002261       NTBP19DA-01   Lp/1
HARRY        2    4pDS1Aal1        4pDS1Aal1        NNTM03011VY8   NTFP80AC-01   Lp/2
HARRY        3    2pJ6MAtm         2pJ6MAtm         NNTM03002W60   NTFP58AA-02   Lp/3
HARRY        4    V11              V11              FT003986       NTBP38EA-01   Lp/4

------------------------------ done -----------------------------------
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Passport Trunk and DPNGate Report (pptrkrep)
This report provides information about trunks and DPN gateways. The 
following information is displayed for each trunk: trunk name, trunk type, 
measured speed, measured delay, configured remote name, and current 
remote endpoint component. 

The following information is displayed for each DPN gateway: DPN gateway 
name, gateway type, measured speed, measured delay, configured remote 
NAMS ID, and current remote endpoint component.

The following example shows a Passport Trunk report.

                         Passport Trunk Report
------------------------------------------------------------------------

                                   Server: bhars836

                                     Date: Tue Feb 15 11:56:08 GMT 2000

Node Name:  GEORGE  (in group: ALPHA)
------------------------------------------------------------------------

Trunk     Type      M. Speed   M. Delay   Remote Name  Remote Endpoint
                    (bit/s)    (msec)
--------- --------- ---------- ---------- ------------ ------------------
Trk/1     PORS               0        0.0            
Trk/2     PORS         1917000        1.6              EM/ZIPPY TRK/2
Trk/3     PORS               0        0.0              
Trk/4     PORS               0        0.0              
Trk/31    PORS               0        0.0              
Trk/41    PORS  Atm          0        0.0              
Trk/60    PORS  Atm    1152000        1.0              EM/HARRY TRK/31
Trk/111   PORS  Atm          0        0.0 OXFORD       
Trk/112   PORS  Atm          0        0.0 OXFORD       
Trk/113   PORS  Atm          0        0.0 OXFORD       
Trk/121   PORS  Atm    9984000        0.3 HARRY        EM/HARRY TRK/421
Trk/122   PORS  Atm    9984000        0.2 HARRY        EM/HARRY TRK/422
Trk/123   PORS  Atm    9984000        0.2 HARRY        EM/HARRY TRK/423
Trk/801   PORS  Atm    6144000        0.3 Zippy        EM/ZIPPY TRK/801
Trk/802   PORS  Atm    6144000        0.3 Zippy        EM/ZIPPY TRK/802
Trk/803   PORS  Atm    6144000        0.3 Zippy        EM/ZIPPY TRK/803

------------------------------ done ------------------------------------
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Passport Software Report (ppsoftrep)
This report provides an inventory of the available and active software on a 
Passport module. Additionally, if more than one Passport node is reported, the 
report generates two summaries:

• Active Software Version Summary

• Software Version On Disk Summary

The Passport Software Report displays the name, version, any installed 
patches, and status for each application that is found.

The following example shows a Passport Software Report with the two 
summary reports.

                    Passport Software Report
------------------------------------------------------------------
                    Server: wcary204
                      Date: Thursday November  8 13:49:26 EST 2001
 Node Name:  ROME  (in group: MDMLAB)
--------------------------------------------------------------------
   Application          Version(Patch)                 Status
   -------------------- --------------------------     ------
   aal1Ces              BD0218A                        
   aal1Ces              BD0226A                        
   atmBearerService     BD01A                          
   atmBearerService     BD0216A                        
   atmBearerService     BD0218A                        
   atmBearerService     BD0226A                        active
   atmNetworking        BD01A                          
   atmNetworking        BD0216A                        
   atmNetworking        BD0218A                        
   atmNetworking        BD0226A                        active
   base                 BD01A                          
   base                 BD0216A                        
   base                 BD0218A                        
   base                 BD0226A                        active
   base                 CB0359A                        
   bridge               BD01A                          
   bridge               BD0216A                        
   bridge               BD0218A                        
   bridge               BD0226A                        active
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 frameRelay           BD01A                          
 frameRelay           BD0216A                        
 frameRelay           BD0218A                        
 frameRelay           BD0226A                        active
 inwBase              BD01A                          
 inwBase              BD0216A                        
 inwBase              BD0218A                        
 inwBase              BD0226A                        active
 ip                   BD01A                          
 ip                   BD0216A                        
 ip                   BD0218A                        
 ip                   BD0226A                        active
 ipx                  BD01A                          
 ipx                  BD0216A                        
 ipx                  BD0218A                        
 ipx                  BD0226A                        active
 netSentry            BD01A                          
 netSentry            BD0216A                        
 netSentry            BD0218A                        
 netSentry            BD0226A                        active
 networking           BD01A                          
 networking           BD0216A                        
 networking           BD0218A                        
 networking           BD0226A                        active
 serviceTrace         BD0218A                        
 serviceTrace         BD0226A                        
 sna                  BD01A                          
 sna                  BD0216A                        
 sna                  BD0218A                        
 sna                  BD0226A                        active
 switchedAccess       BD01A                          
 switchedAccess       BD0216A                        
 switchedAccess       BD0218A                        
 switchedAccess       BD0226A                        active
 testTools            BD01A                          
 testTools            BD0216A                        
 testTools            BD0218A                        
 testTools            BD0226A                        active
 trunks               BD01A                          
 trunks               BD0216A                        
 trunks               BD0218A                        
 trunks               BD0226A                        active
 trunks               CA0226A                        
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 vns                  BD01A                          
 vns                  BD0216A                        
 vns                  BD0218A                        
 vns                  BD0226A                        active
 vtds                 BD01A                          
 vtds                 BD0216A                        
 vtds                 BD0218A                        
 vtds                 BD0226A                        active
 wanDte               BD01A                          
 wanDte               BD0216A                        
 wanDte               BD0218A                        
 wanDte               BD0226A                        active

Node Name:  ATHENS  (in group: MDMLAB)
--------------------------------------------------------------------

 Application          Version(Patch)               Status
 -------------------- ---------------------------  ------
 aal1Ces              CB0031B                        
 aal1Ces              CB02S3E                        
 aal1Ces              CC0067A                        active
 atmNetworking        CB0031B                        
 atmNetworking        CB02S3E                        
 atmNetworking        CC0067A                        active
 atmNetworking        UWM34AEd                       
 base                 CB0031B                        
 base                 CB02S3E                        
 base                 CC0067A                        active
 base                 UWM34AEd                       
 frameRelay           CB0031B                        
 frameRelay           CB02S3E                        
 frameRelay           CC0067A                        active
 frameRelay           UWM34AEd                       
 ip                   CB0031B                        
 ip                   CB02S3E                        
 ip                   CC0067A                        active
 ip                   UWM34AEd                       
 networking           CB0031B                        
 networking           CB02S3E                        
 networking           CC0067A                        active
 networking           UWM34AEd                       
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Active Software Version Summary
--------------------------------------------------------------------

 Application          Version(Patch)                 Number
 --------------------   ------------------------------   ------

Software Version On Disk Summary
--------------------------------------------------------------------

 Application          Version(Patch)                 Number 
 -------------------    ------------------------------   ------

------------------------------ done ------------------------------------

Passport Frame Relay Services Report (ppfrrep)
This report provides an inventory of the Frame Relay services and 
connections that are available on a Passport module. The following 
information is displayed for each Frame Relay service: interface name, 
logical processor, customer ID, LMI type, and DNA.

The following information is displayed for each Frame Relay connection that 
is found: DLCI name, connection type, CIR, EIR, rate enforcement status, 
rate adaptation status, remote DNA, and remote DLCI.

The following example shows a Passport Frame Relay Services Report.

 Passport Frame Relay Services Report
------------------------------------------------------------------------
                                    Server: bhars836
                                      Date: Tue Feb 15 11:56:47 GMT 2000

Node Name:  GEORGE  (in group: ALPHA)
------------------------------------------------------------------------

 Frame Relay Service: FrUni/30
   Logical Processor: Lp/3 X21/0
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         Customer ID: 0
            LMI Type: none
                 DNA: x121 111170020030

DLCI Type CIR       EIR      Rate      Rate       Remote DNA       Rem.
          (bits/s)  (bits/s) Enforced  Adaptation                  DLCI
---- ---- --------- -------- --------- ---------- ---------------------
50   pvc      64000        0 no        no         x121 111170010000  16
51   pvc      64000        0 no        no         x121 111170020000  16
52   pvc      64000        0 no        no         x121 111170030000  17
53   pvc      64000        0 no        no         x121 111170040000  17

 Frame Relay Service: FrUni/33
   Logical Processor: Lp/3 X21/3
         Customer ID: 0
            LMI Type: ansi
                 DNA: x121 111170020033

DLCI Type CIR       EIR      Rate      Rate       Remote DNA       Rem.
          (bits/s)  (bits/s) Enforced  Adaptation                  DLCI
---- ---- --------- -------- --------- ---------- ---------------------
200  pvc      64000         0 yes      no         x121 111170010033 200

------------------------------ done ------------------------------------
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Passport ATM Services Report (ppatmrep)
This report provides an inventory of the ATM services and connections that 
are available on a Passport module. The following information is displayed 
for each ATM service: AtmIf name and type, logical processor, customer ID, 
number of configured permanent VCCs and VPCs, number of active switched 
VCCs, number of troubled VCCs and VPCs, traffic shaping state, UPC state, 
and total admitted and available bandwidth.

The following information is displayed for each ATM connection: VCC/VPC 
name, connection type, service category, OAM segment type, transmit side 
traffic type and QoS, receive side traffic type and QoS, traffic shaping and 
UPC shapes, and end/relay component name.

The following example shows a Passport ATM Services Report.

                  Passport ATM Services Report

--------------------------------------------------------------------

                                Server: bcaruff9

                                  Date: Wed Apr 10 13:41:26 EDT 2002

Node Name:  ATLANTA  (in group: MDMLAB)

--------------------------------------------------------------------

         ATM Service: AtmIf/10 (PUNI)

   Logical Processor: Lp/1 DS3/0 

Remote ATM Interface: n/a

         Customer ID: 0

           Permanent: VCCs: 5  VPCs: 2

            Switched: VCCs: 13

            Troubled: VCCs: 0  VPCs: 0

           Bandwidth: Admitted: 1089  Available: 103179

Vcc/Vpc       Type  Role  Categ. Tx  QOS  Rx  QOS  Shap UPC  End/Relay Point

------------- ----- ----- ------ --- ---- --- ---- ---- ---- --------------- - - -

Vcc/0.5       EP    conEP rtVbr  6        6        off  off  ATMIF/10 PNNI SIG

Vcc/0.18      EP    conEP rtVbr  8        8        off  off  ATMIF/10 PNNI RCC

Vcc/0.66      RP    segEP cbr    1        1        n/a  n/a  ATMIF/10 VCC/0.207 RP
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Vcc/0.67      RP    segEP cbr    1        1        n/a  n/a  ATMIF/10 VCC/0.208 RP

Vcc/0.68      RP    segEP cbr    3        3        n/a  off  ATMIF/10 VCC/0.209 RP

Vcc/0.75      NRP   segEP ubr    3        3        off  off  ATMIF/11 VCC/0.75 NRP

Vcc/0.85      TM    unkn  ubr    1        1        n/a  n/a  

Vcc/0.207     RP    segEP cbr    1        1        n/a  n/a  ATMIF/10 VCC/0.66 RP

Vcc/0.208     RP    segEP cbr    1        1        n/a  n/a  ATMIF/10 VCC/0.67 RP

Vcc/0.209     RP    segEP cbr    3        3        n/a  off  ATMIF/10 VCC/0.68 RP

Vcc/0.629     RP    segEP ubr    1        1        n/a  n/a  ATMIF/11 VCC/0.80 RP

Vcc/0.630     RP    segEP cbr    3        3        n/a  off  ATMIF/11 VCC/0.150 RP

Vcc/0.632     RP    segEP cbr    1        1        n/a  n/a  ATMIF/11 VCC/0.152 RP

Vcc/0.634     RP    segEP ubr    1        1        n/a  n/a  ATMIF/11 VCC/0.170 RP

Vcc/0.635     RP    segEP ubr    1        1        n/a  n/a  ATMIF/11 VCC/0.50 RP

Vcc/0.637     RP    segEP cbr    1        1        n/a  n/a  ATMIF/11 VCC/0.117 RP

Vcc/0.639     RP    segEP cbr    1        1        n/a  n/a  ATMIF/11 VCC/0.197 RP

Vcc/0.640     RP    segEP cbr    3        3        n/a  off  ATMIF/11 VCC/0.56 RP

Vpc/20        NRP   segEP ubr    3        3        off  off  ATMIF/11 VPC/20 NRP

Vpc/25        NRP   segEP ubr    3        3        off  off  ATMIF/11 VPC/25 NRP

Vpc/124       RP    segEP ubr    1        1        n/a  n/a  ATMIF/11 VPC/10 RP

Vpc/125       RP    segEP ubr    1        1        n/a  n/a  ATMIF/11 VPC/11 RP

Vpc/126       RP    segEP cbr    1        1        n/a  n/a  ATMIF/11 VPC/100 RP

Vpc/127       RP    segEP cbr    1        1        n/a  n/a  ATMIF/11 VPC/101 RP

         ATM Service: AtmIf/11 (PUNI)

   Logical Processor: Lp/1 DS3/1 

Remote ATM Interface: n/a

         Customer ID: 0

           Permanent: VCCs: 4  VPCs: 5

            Switched: VCCs: 9

            Troubled: VCCs: 0  VPCs: 0

           Bandwidth: Admitted: 1083  Available: 103185

Vcc/Vpc       Type  Role  Categ. Tx  QOS  Rx  QOS  Shap UPC  End/Relay Point

------------- ----- ----- ------ --- ---- --- ---- ---- ---- --------------- - - -

Vcc/0.5       EP    conEP rtVbr  6        6        off  off  ATMIF/11 PNNI SIG

Vcc/0.18      EP    conEP rtVbr  8        8        off  off  ATMIF/11 PNNI RCC

Vcc/0.50      RP    segEP ubr    1        1        n/a  n/a  ATMIF/10 VCC/0.635 RP

Vcc/0.56      RP    segEP cbr    3        3        n/a  off  ATMIF/10 VCC/0.640 RP

Vcc/0.66      TM    unkn  cbr    1        1        n/a  n/a  ATMIF/10 VCC/0.207 RP
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Vcc/0.75      NRP   segEP ubr    3        3        off  off  ATMIF/10 VCC/0.75 NRP

Vcc/0.80      RP    segEP ubr    1        1        n/a  n/a  ATMIF/10 VCC/0.629 RP

Vcc/0.100     NEP   conEP ubr    1        1        n/a  n/a  ATMMPE/14 AC/1

Vcc/0.117     RP    segEP cbr    1        1        n/a  n/a  ATMIF/10 VCC/0.637 RP

Vcc/0.150     RP    segEP cbr    3        3        n/a  off  ATMIF/10 VCC/0.630 RP

Vcc/0.152     RP    segEP cbr    1        1        n/a  n/a  ATMIF/10 VCC/0.632 RP

Vcc/0.170     RP    segEP ubr    1        1        n/a  n/a  ATMIF/10 VCC/0.634 RP

Vcc/0.197     RP    segEP cbr    1        1        n/a  n/a  ATMIF/10 VCC/0.639 RP

Vpc/10        RP    segEP ubr    1        1        n/a  n/a  ATMIF/10 VPC/124 RP

Vpc/11        RP    segEP ubr    1        1        n/a  n/a  ATMIF/10 VPC/125 RP

Vpc/12        TM    unkn  ubr    1        1        n/a  n/a  

Vpc/20        NRP   segEP ubr    3        3        off  off  ATMIF/10 VPC/20 NRP

Vpc/25        NRP   segEP ubr    3        3        off  off  ATMIF/10 VPC/25 NRP

Vpc/100       RP    segEP cbr    1        1        n/a  n/a  ATMIF/10 VPC/126 RP

Vpc/101       RP    segEP cbr    1        1        n/a  n/a  ATMIF/10 VPC/127 RP

------------------------------ done --------------------------------

Passport Frame Relay ATM Services Report (ppfratmrep)
This report provides an inventory of the Passport frame relay to ATM (FR-
ATM) service and connections that are available on the Passport module. The 
report displays the following information for each FR-ATM service:

• FR-ATM name

• logical processor (Lp)
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• customer ID

• Local Management Interface (LMI) type

• total admitted and available bandwidth

The report displays the following information for each frame relay to ATM 
connection that is found:

• DLCI name

• connection type

• committed information rate (CIR) in bits/s

• excess information rate (EIR) in bits/s

• rate enforcement status

• service category

• remote address

• remote CI

• next hop

The following example shows a Passport Frame Relay ATM Services report. 

                  Passport Frame Relay ATM Services Report

--------------------------------------------------------------------

                                Server: bcaruff9

                                  Date: Wed Apr 10 14:24:34 EDT 2002
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Node Name:  NAGANO  (in group: MDMLAB)

--------------------------------------------------------------------

 Frame Relay ATM Service: FrAtm/20

       Logical Processor: Lp/2 

             Customer ID: 0

                LMI Type: autoConfigure

               Bandwidth: Admitted: 0  Available: 0

DLCI Type CIR        EIR        Rate       Service  Remote Address                           
Remote   Next Hop

          (bits/s)   (bits/s)   Enforced   Category                                          
CI       

---- ---- ---------- ---------- ---------- -------- --------------------
-------------------- -------- -------------------------

16   siwf 56         n/a        off                                                                   
AtmIf/12 Vcc/0.120 Nep   

33   siwf 64000      n/a        on                                                                    
AtmIf/10 Vcc/0.33 Nep    

35   siwf 64         n/a        off                                                                   
AtmIf/10 Vcc/0.139 Nep   

36   siwf 64         n/a        off                                                                   
AtmIf/10 Vcc/0.138 Nep   

37   siwf 64         n/a        off                                                                   
AtmIf/12 Vcc/0.175 Nep   

49   siwf 64         n/a        off                                                                   
AtmIf/10 Vcc/0.35 Nep    

106  siwf 60         n/a        off                                                                   
AtmIf/10 Vcc/0.106 Nep   

107  siwf 58         n/a        off                                                                   
AtmIf/10 Vcc/0.107 Nep   
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111  siwf 64000      n/a        off                                                                   
AtmIf/12 Vcc/0.46 Nep    

119  siwf 56         n/a        off                                                                   
AtmIf/10 Vcc/0.36 Nep    

127  siwf 64000      n/a        off                                                                   
AtmIf/10 Vcc/0.151 Nep   

128  siwf 128000     n/a        off                                                                   
AtmIf/10 Vcc/0.152 Nep   

129  siwf 64000      n/a        off        ubr      
471391111111111111111111B00020480D000A00 0.166    AtmIf/10 Vcc/0.166 Ep    

130  siwf 64000      n/a        off        ubr      
471391111111111111111111A00020480D000A00 0.162    AtmIf/10 Vcc/0.293 Ep    

132  siwf 128000     n/a        off        ubr      
471391111111111111111111A00020480D000A00 0.163    AtmIf/10 Vcc/0.292 Ep    

136  siwf 64         n/a        off                                                                   
AtmIf/10 Vcc/0.136 Nep   

137  siwf 0          n/a        off                                                                   
AtmIf/10 Vcc/0.137 Nep   

140  siwf 56         n/a        off                                                                   
AtmIf/12 Vcc/0.35 Nep    

 Frame Relay ATM Service: FrAtm/1000

       Logical Processor: Lp/2 

             Customer ID: 0

                LMI Type: autoConfigure

               Bandwidth: Admitted: 0  Available: 0

DLCI Type CIR        EIR        Rate       Service  Remote Address                           
Remote   Next Hop
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          (bits/s)   (bits/s)   Enforced   Category                                          
CI       

---- ---- ---------- ---------- ---------- -------- --------------------
-------------------- -------- -------------------------

16   siwf 40000      n/a        off                                                                   
AtmIf/12 Vcc/0.115 Nep   

------------------------------ done --------------------------------
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DPN Inventory Reports

This appendix provides examples of the reports that come with the DPN 
Inventory Reports tool. See the following sections for information on these 
reports:

• “DPN Module Report (dpnmodrep)” (page 68)

• “DPN Module Summary (dpnsumrep))” (page 69)

• “DPN PE Report (dpnperep))” (page 70)

• “DPN PI Report (dpnpirep)” (page 71)

• “DPN SCR Report (dpnscrrep)” (page 73)

• “DPN Network Links and Trunks Report (dpnnetrep)” (page 75)
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DPN Module Report (dpnmodrep)
This report provides a full inventory of a DPN module, including the node 
name, NAMS ID, node type, model, number of shelves, common memory, 
maximum subnet packet size, and information about disk capacity. In 
addition, it includes all of the information contained in the DPN PE Report 
and DPN PI Report.

For an example of a DPN Module Report, see the figure “DPN Module 
Report” (page 68).

Figure 10
DPN Module Report
241-6001-808   15.1RSUP   



Appendix B DPN Inventory Reports   69
DPN Module Summary (dpnsumrep))
This report carries all of the information contained in the DPN Module Report 
(module name, NAMS ID, node type, model, number of shelves, common 
memory, and maximum subnet packet size) except for the information from 
the DPN PE Report and DPN PI Report.

The following example shows a DPN Module Summary Report.

                          DPN Module Summary Report
------------------------------------------------------------------------
                              Server: whars062
                                     Date: Tuesday August 24 10:29:05 BST 1999
                                  OA: bnroa

Module Name  NAMSID Type Model         Shelves CM      Subnet Pkt Size  
------------ ------ ---- ------------- ------- ------  ---------------
AM1          1002    AM  DPN-100 AM/RM     1   2 CM16        512

------------------------------ done ------------------------------------
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DPN PE Report (dpnperep))
This report provides a full inventory of the PEs present in a DPN module. The 
following information is displayed for each PE that is found: module name, 
PE number, type, memory, Muxdma operating mode, image, and software 
generic.

The following example shows a DPN PE Report.

                             DPN PE Report
------------------------------------------------------------------------
                              Server: whars062
                                      Date: Tuesday August 24 09:53:02 BST 1999
                                  OA: bnroa

Module Name      PE  Type          Mem   Muxdma    Image      Generic
---------------- --- ------------- ----- --------- ---------- -------
AM1              1   PE386         2048K no        AMOFF386   G36
AM1              2   PE386         2048K no        CSERV386   G36
AM1              3   PE386         2048K no        UTP386     G36
AM1              4   PE386         2048K no        FRELAY     G36
AM1              5   PE386         2048K no        FRELAY     G36
AM1              6   PE386         2048K no        X25DP386   G36
AM1              7   PE386         2048K no        X25DP386   G36
AM1              8   PE386         2048K no        X25B386    G36
AM1              9   PE386         2048K no        X25B386    G36
AM1              10  PE386          863K no        PELFG1     G36
AM1              11  PE386          863K no        PELFG1     G36
AM1              12  PE386         2048K no        UTP386     G36
AM1              13  PE386         2048K no        FRELAY     G36
AM1              14  PE386         2048K no        AMOFF386   G36

------------------------------ done ------------------------------------
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DPN PI Report (dpnpirep)
This report provides a full inventory of the PIs present in a DPN module. The 
following information is displayed for each PI that is found: module name, 
PE number, PI number, type, and number of ports.

The following information is displayed for each port: port number, protocol, 
and configured speed.

The following example shows a DPN PI Report.

                             DPN PI Report
------------------------------------------------------------------------
                                Server: whars062
                                      Date: Tuesday August 24 09::57 BST 1999
                                    OA: bnora

Module Name   PE PI  PI Type            No of Ports  Port Protocol  Speed (bps)
------------ -- -- --------------- ----------- ------------- --------  
AM1          1  1  V35_SCSI             0                            
AM1          2  2  V36_FOUR_PORT        0                            
AM1          3  3  V35_SCSI             2        1       UTP      64K
AM1          3  3  V35_SCSI                      2       UTP    19.2K
AM1          4  4  PRIMARY_RATE         1        1       FRS    2048K
AM1          5  5  PRIMARY_RATE         1        1       FRS    2048K
AM1          6  6  PRIMARY_RATE         1        1  LAPD/X25      64K
AM1          7  7  PRIMARY_RATE         1        1  LAPD/X25      64K
AM1          8  8  V24_FOUR_PORT        3        1       X25     9600
AM1          8  8  V24_FOUR_PORT                 2       X25     9600
AM1          8  8  V24_FOUR_PORT                 3       X25     9600
AM1          9  9  V24_FOUR_PORT        4        1       X25     9600
AM1          9  9  V24_FOUR_PORT                 2       X25     9600
AM1          9  9  V24_FOUR_PORT                 3       X25     9600
AM1          9  9  V24_FOUR_PORT                 4       X25     9600
AM1          10 10 V24_EIGHT_PORT       8        1       ITI     9600
AM1          10 10 V24_EIGHT_PORT                2       ITI     9600
AM1          10 10 V24_EIGHT_PORT                3       ITI     9600
AM1          10 10 V24_EIGHT_PORT                4       ITI     9600
AM1          10 10 V24_EIGHT_PORT                5       ITI     1200
AM1          10 10 V24_EIGHT_PORT                6       ITI     1200
AM1          10 10 V24_EIGHT_PORT                7       ITI     9600
AM1          10 10 V24_EIGHT_PORT                8       ITI     9600
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AM1          11 11 V24_FOUR_PORT        4        1       ITI     1200
AM1          11 11 V24_FOUR_PORT                 2       ITI     9600
AM1          11 11  V24_FOUR_PORT                3      ITI      9600
AM1          11 11  V24_FOUR_PORT                4      ITI      9600
AM1          12 12  V35_SCSI             2       1      UTP       64K
AM1          12 12  V35_SCSI                     2      UTP     19.2K
AM1          13 13  V24_EIGHT_PORT       2       1      FRS      256K
AM1          13 13  V24_EIGHT_PORT       2       1      FRS      256K
AM1          14 14  V35_SCSI             0                            

------------------------------ done ------------------------------------
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DPN SCR Report (dpnscrrep)
This report provides a table of source call router (SCR) entries for an RM 
module. The following information is displayed for each SCR entry: network 
plan indicator (NPI), destination DNA, RID (for intra-network calls) or NID 
(for inter-network calls), and RID/NID value.

The following example shows a DPN SCR Report.

                            DPN SCR Report
------------------------------------------------------------------------
                                    Server: bhars786
                                      Date: Tue Feb 17 11:31:09 GMT 1999
                                        OA: BNRMDI

Module: RM1
SCR: 2

NPI  DNA                  Type Value
---- -------------------- ---- -----
x121 1111009 1             RID    91
x121 1111009 2             RID    92
x121 1111009 3             RID    93
x121 1111100 1             RID     1
x121 1111100 20904         NID  1351
x121 1111100 2             RID     1
x121 1111100 3             RID     1
x121 1111123 44            NID  1234
x121 1111123 4             NID  1234
x121 1111200 1             RID     2
x121 1111200 2             RID     1
x121 1111234 5             NID  2000
x121 1111300               RID     3
x121 1111666 6             RID     3
x121 1111700 1             RID     7
x121 1111700 2             RID     7
x121 111197                NID   250
x121 2352                  NID  1400
x121 2353                  NID  1450
x121 2371987               NID  1371
x121 2371                  NID  1000
x121 245612                NID  1000
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x121 245659                RID     4
x121 2468                  NID  1100
x121 2624111 1             RID     1
x121 3030                  NID   300
x121 3143                  NID  1550
x121 3333                  RID    10
x121 3456122 00            NID  1000
x121 345659                RID     4
x121 4270                  NID   427
x121 4280                  NID   428
x121 4321                  NID  1500
x121 7999                  NID  1000
x121 8999                  RID     1
e164 0628                  DSR     1
e164 0753                  DSR     2

------------------------------ done ------------------------------------
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DPN Network Links and Trunks Report (dpnnetrep)
This report provides a list of the network links and trunks that are available 
on a DPN module. The following information is displayed for each network 
link and trunk: PI, PO, speed, Muxdma operating mode of the PE, PE number, 
and destination node NAMS ID.

The following example shows a DPN Network Links and Trunks Report.

                 DPN Network Links and Trunks Report
------------------------------------------------------------------------
                                   Server: bhars786
                                     Date: Tue Feb 17 11:31:36 GMT 1999
                                       OA: BNRMDI

Module: AM1

Network Links:

PI PO Speed (bps) Muxdma PE  Destination (Namsid)
-- -- ----------- ------ --  --------------------
 3  1      64K    no      3  2002     
12  1      64K    no     12  1001     

------------------------------ done ------------------------------------
Preside MDM Device Inventory Tools User Guide   15.1RSUP



76   Appendix B DPN Inventory Reports
241-6001-808   15.1RSUP   





Preside Multiservice Data Manager

Device Inventory Tools
User Guide

Release: R15.1

Copyright © 2004 Nortel Networks.
All Rights Reserved.

NORTEL, NORTEL NETWORKS, the globemark design, the 
NORTEL NETWORKS corporate logo, PASSPORT, PRESIDE,and 
DPN are trademarks of Nortel Networks. UNIX is a trademark 
licensed exclusively through X/Open Company Ltd.

Publication: 241-6001-808
Document status: Standard
Document version: 15.1RSUP
Document date: August 2004
Printed in Canada 


	Publication history
	Contents
	About this document
	Who should read this document and why
	What you need to know
	How this document is organized
	What’s new in this document
	Text conventions
	Related documents

	Introducing the Inventory Reports tools
	About the Inventory Reports tools
	Inventory Reports configuration files
	Customizing and creating reports
	Starting the Inventory Reports tools

	Passport Inventory Reports tool
	About the Passport Inventory Reports tool
	Starting the Passport Inventory Reports tool
	Customizing and creating Passport Inventory Reports
	Passport inventory reports configuration file
	Configuration file location
	Configuration file format

	Passport Inventory Reports tool window
	Menu bar
	Passport Group field
	Module field
	Report area

	Passport Inventory Reports tool dialogs
	Passport Authentication dialog
	Card Inventory Options dialog
	Save Report to File dialog
	Print Report dialog

	Passport Inventory Reports tool procedures
	Producing reports using the Passport Inventory Reports tool window
	Producing reports using a command line

	Using the keyboard

	DPN Inventory Reports tool
	About the DPN Inventory Reports tool
	Starting the DPN Inventory Reports tool
	Customizing and creating DPN inventory reports
	DPN inventory reports configuration file
	Configuration file location
	Configuration file format

	DPN Inventory Reports tool window
	Menu bar
	OA data field
	Module data field
	Report area

	DPN Inventory Reports tool dialogs
	OA Authentication dialog
	Save Report to File dialog
	Print Report dialog

	DPN Inventory Reports tool procedures
	Producing reports using the DPN Inventory Reports tool window
	Producing reports using a command line

	Using the keyboard

	Appendix�A Passport Inventory Reports
	Available Passport Groups and Modules (pplistrep)
	Passport Full Module Report (ppmodrep)
	Passport Card Inventory (ppcardrep)
	Passport Trunk and DPNGate Report (pptrkrep)
	Passport Software Report (ppsoftrep)
	Passport Frame Relay Services Report (ppfrrep)
	Passport ATM Services Report (ppatmrep)
	Passport Frame Relay ATM Services Report (ppfratmrep)

	Appendix�B DPN Inventory Reports
	DPN Module Report (dpnmodrep)
	DPN Module Summary (dpnsumrep))
	DPN PE Report (dpnperep))
	DPN PI Report (dpnpirep)
	DPN SCR Report (dpnscrrep)
	DPN Network Links and Trunks Report (dpnnetrep)


